Volunteer Hours Report
Generator

This guide is to help you get started on using the Automated
Volunteer hours Report Generator.
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Intent

The Automated Volunteer hours spreadsheet is a Google Spreadsheet with an
attached program that is used to automate the building of reports from
volunteer hours data. The intent is to provide an easy way to generate
volunteer hour reports for our partner agencies to communicate OET'’s volunteer
worth for the past reporting year. Simply enter volunteer hours data in one
place, and from a menu item run the report program. The report program then
sorts and totals the data creating 10 different reports. The intent of this is not to
replace the current paper volunteer project work documents OET has used for
many years for work projects, but additionally provide a simple and easy way to
generate volunteer hour reports for agency partners.

Accessing the Volunteer Reporting Spreadsheet with a
Google Account

The Volunteer Hours Reporting Spreadsheet must be accessed and run over the
internet. This is a cloud based application and can’t be installed and run on a
local PC. An advantage of cloud based application is multiple users accessibility
to a single application and its data, plus Chapter volunteer hour data can be
collected automatically for state use.

The Volunteer Hours Reporting Spreadsheet uses the free Google Sheets cloud
based application. Access to the Google Sheets app requires you to have a
Google Account. The one Google account provides access to a number of free
Google Cloud Based Applications. The one user account provides access to
Gmail, Youtube , Groups , Calendar , Drive (access to the Volunteer
Reporting Automated Spreadsheet), Sheets (add Event data from Hours Report
form), Docs and a number of other Google Cloud Based Applications.

When you initially create your Google account you are required only to enter:

1. A unique email address ending in @gmail.com. This represents your user
name and what is used to share Cloud Application resources to you. Your
Chapter’s name would be a good choice, i.e. centraloregon@gmail.com
Some text in the Firstname field, i.e. Central

Some text in the Lastname field, i.e. Oregon

A password that at least 2 Chapter officers will know

A Date proving you are older than 18.

A phone number capable of Text Messaging or an alternate email address
as a way to recover your account password it you ever forget it.

oA wWwN

No other personal information is required.
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This account is how you would be given access to open the Volunteer Reporting
Automated Spreadsheet and add your Chapter's volunteer hours to create the
individual and agency reports. You are not required to use this Google account
for email.

Distributing the Online Volunteer Hours Spreadsheet

Chapter Chairs will receive an email message like the example below. The email
will provide some basics on getting started. The email will include the web link to
your Chapter's master Volunteer Hours Spreadsheet. This file will not be directly
editable, you must follow the instructions to make a copy to your Google account
or to your Chapter’s OET Cloud account. See the section below on Managing
your Chapter’s Volunteer Reporting spreadsheet.

Dear (your-chapter) Volunteer Hours Coordinator,

This message was automatically generated and provides information on how to access
your Chapters new online Volunteer Hours Reporting method. The new online
Volunteer Hours Reporting method involves opening a spreadsheet through, OET
Cloud Services, entering the volunteer work hours randomly throughout the reporting
year for any project for any Chapter member. A Report Generator Program can be run
at any time automatically producing numerous report sheets for your Chapters use.
Currently the Report Generator Program produces the following reports for the
specified report year.

e \Volunteer Totals Report showing your Chapter's volunteer hours and $dollar
values totals, for Jan. 1st to Dec. 31st
Volunteer Totals By Individual, for Jan. 1st to Dec. 31st.
Volunteer Totals By Individual without OET Administrative, for Jan. 1st to Dec.
31st.

e Volunteer Totals By Agency,(FS, BLM, OPRD, ODF, ODFW, County, & Other)
Jan. 1st to Dec. 31st
Volunteer Totals By Individual, for State Parks (ORPD), Jan. 1st to Dec. 31st
Volunteer Totals By Individual, for US Forest Service District 6, Oct. 1, (of
previous year) to Sep. 31, (of current report year)

e \Volunteer Totals By Individual, for Bureau of Land Management (BLM) 6, Oct.
1, (of previous year) to Sep. 31, (of current report year)

e Volunteer Totals By Individual, for Oregon Department of Forestry (ODF), Jan.
1st to Dec. 31st

e Volunteer Totals By Individual, for Oregon Department of Fish & Wildlife
(ODFW), Jan. 1st to Dec. 31st

e Volunteer Totals By Individual, for Local County or City Municipal Parks, Jan.
1st to Dec. 31st

Below is the direct web link to the online Volunteer Hours Reporting Spreadsheet
named: <Chapter Initials>-ChapVolHoursRpt.

https://docs.google.com/a/apps.oregonequestriantrails.org/spreadsheets/d/1KfL9E0Q
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EL1YAz7tDde4dm7WOpPfuBRAz5-VHII2rGBuo/edit?usp=drivesdk

This is the direct web link to the Spreadsheet on the OET Cloud account. When you
click on the link to open the online Spreadsheet, you will need to login to your
personal Google account or if assigned a OET Cloud account,
(your-chapter@apps.oregonequestriantrails.org). It will first be opened in read only
mode. Next you will need to make a copy, enabling you to enter your Chapter's
volunteer hours. To make a copy of the Volunteer Hours Reporting spreadsheet to
your OET Cloud account or personal account under the Google Drive App:

e To make a copy of the spreadsheet and save it to Google Drive, select
File->Make a Copy.

Once a copy is made to your Google Drive you can enter your Chapter's volunteer
hours and run the report generator by:

e To run report, select Build Reports->By Agencies and Individuals

Open the Online Spreadsheet Data tab, enter your Chapter's volunteer hours and
select Build Reports->By Agencies and Individuals.

For more information please see our on-line Help.

Managing your Chapter's Volunteer Hours Spreadsheet

Each Chapter will initially be provided their own Chapters master volunteer
reporting spreadsheet. This is provided via the web link in the email sent to your
Chapter but is also available on the OET SHared Drive. You are required to make
a copy of the master so you have a backup copy. Each time you make a copy of
the Chapter’s master Volunteer Reporting Spreadsheet you are creating an
active spreadsheet. There should only be one active spreadsheet in use by your
Chapter at any given time, however you can allow multiple Chapter members to
enter volunteer hours to the Chapter’s one active spreadsheet by using the
Sharing feature. See the section on sharing your Chapter’s active spreadsheet.

Scenario 1 - Choose to have the Chapter’s active spreadsheet reside in the
Chapters OET Cloud Account.

1. Login to the Chapter’s OET Cloud account.

2. Open the Chapter’s master volunteer reporting spreadsheet and make a
copy to create the active spreadsheet under "My Drive”.

3. Once in the Chapter’s active spreadsheet click on the Share button and
enter the Gmail users in your Chapter who will be entering volunteer
hours.

Scenario 2 - Choose to have the Chapter’s active spreadsheet reside in any
Google Account.

1. Login to a personal Google account or a personal account you have made
for your Chapter’s use.
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2. Open the Chapter’s master volunteer reporting spreadsheet and make a
copy to create the active spreadsheet under *My Drive”.

3. Once in the Chapter’s active spreadsheet click on the blue Share button
and enter the Gmail users in your Chapter who will be entering volunteer
hours.

Scenario 1 is the recommended way so future leaders of your Chapter will have
access to the prior years volunteer hours for the Chapter, the other method is
also supported.

Making the Chapter's Active Spreadsheet Copy

There are two ways to access the Chapter’s master volunteer reporting
spreadsheet, 1) The Chapter Chair will have received an email message
containing the web link to the Chapter’s master volunteer hours spreadsheet or
2) directly from the OET Shared Drive.

Make a Copy from the email message

1. Open the email message and click on the web link to open the Chapter’s
master volunteer hours spreadsheet.

2. If not already logged in to a Google account, login when prompted.

. In the Spreadsheet window, select File->Make a Copy

4. Enter a filename you want to use. Make sure it contains your Chapter’s
name or initials.

5. Click on OK to Make a Copy. The new file will automatically open, and it is
saved directly into the "My Drive” folder under Google Drive.

[€Y)

Make a Copy from your Google Drive account

1. Login to your Google account and open the Google Drive App found in the

drop-down when you pick the square of dots in the upper right area of the

Google page.

Double click to open the OET Shared Drive folder.

Double click to open the OET Cloud Services folder.

Double click to open the Volunteer Hours Scripts folder.

Double click to open the ChapterVolunteerHoursReports folder.

Double click to open the Chapter’s master volunteer reporting

spreadsheet. The name will begin with your Chapter’s initials followed by

nn-ChapVolHoursRpt.

7. In the Spreadsheet window, select File->Make a Copy

8. Enter a filename you want to use. Make sure it contains your Chapter’s
name or initials.

9. Click on OK to Make a Copy. The new file will automatically open, and will
be saved directly into the "My Drive” folder under Google Drive.

oOunhwnN
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Reporting Your Chapter's Volunteer Hours to VP Field Services

Reporting of your Chapters hours is now automatic. The active Chapter’s
spreadsheet will automatically communicate its location and identification to
allow the VP of Field Services to automatically pull reported hours during the
reporting year from each Chapter's active spreadsheet at any time day or night.
You no longer need to email or mail your Chapters hours to OETs VP of Field
Service.

Sharing the Chapter’s Active Spreadsheet

The active volunteer reporting spreadsheet in use by your Chapter can easily be
shared to any member with a Google account. Once shared and given edit
rights they can open the active volunteer reporting spreadsheet and add
volunteer hours. The intent here is not to give everyone edit access but limit it
to those who are tasked with managing the Chapter's volunteer hours which is
normally the Chapter’s field services officer, your work crew leaders and other
Chapter leaders. As another option you could offer all members read only
access so they can view the progress at any time.

How to Share the Active Spreadsheet

1. There are two ways to access the sharing settings of the spreadsheet.
From your Google Drive window right click over the active file name and
select Share from the file view menu,
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L Drive My Drive > OET Cloud Services > Volunteer Hour Scripts > ChapterVolunteerHoursReports ~
“ Name | Owner Last modified File size
v B3 MyoDrive . NV-ChapVolHoursRpt &% me Feb 28,2016 E=
F @ Preview
ann  Shared with me CO-Chapy ne Feb 21,2016 B
4-:+ Open with >
2% Goo gle Photos
® Recent | ‘& share.
* Starad CD Getlink
— Move to...
B Trash
Y Addstar
37 MB of 30 GB used Rename...

== Upgrade storage
View details

|_|:| Make a copy
oo

Download

i Remove

2. Another way is to click on the blue “"Share” button in the upper right hand
corner while the Chapter’s active spreadsheet is open.

i= NV-ChapVolHoursRpt s il S
File Edit View Insert Format Data Tools Add-ons Help Build Reports Last  ~~ Comments
L= alle E § % .0_ .00 123-  Arial - 10 - B Z &£ A. ®.@- More -
A ] [+ D E F G

: Oregon Equestrian Trails

2 Volunteer Hours Report for 2016

3 North Valley Chapter

4

5 Rate per Edit
& Totals hour/mile/day Total Value Curren
7 Total Skilled Hours 0 534.61 $0.00 | Calculated per hour 1
B Total Basic Hours 0 $23.07 $0.00| Calculated per hour i
2 Total Education 0 523.07 $0.00| Calculated per hour i
10 Total Public Meetings 0 523.07 $0.00 | Calculated per hour 1
i1 Total Travel Time 0 523.07 $0.00 | Calculated per hour 1
12 Total Hours 0

13

14 Personal Vehicle 0 5090 $0.00 | Calculated per mile

15 Stock Hauling 0 $1.10 $0.00| Calculated per mile

18 Total Travel Miles ] >

+ = | TOTALS ~ |[NVInd ~ | NVAgency - |Data - | &' |«
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3. With the Sharing window open just enter the Gmail addresses of the
members you want to share the spreadsheet to. Make sure it says “Can
Edit”. When finished click on “Done”.

Share with others Get shareable link 2

FPeople

F Can edit -

4. As you enter names you will be given an opportunity to include a note to
the users you have shared the spreadsheet to. This will cause an
automatic email message to be sent that will include the web link to the
Chapters active spreadsheet. Click on “Send”.

Share with others Get shareable link 2
People
2 Marty Devall x| : # Can edit -

Motify people [+

5. Next you will see the prompt ‘are you sure?’, click “Yes”. The email
message sent will include your note along with the direct web link to your
Chapter’s spreadsheet.
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Lindy & Marty Co-Chairs has invited you to edit the following spreadsheet:
Copy of NV-ChapVolHoursRpt

Google Sheets: Create and edit spreadsheets online.

6. When the link is clicked on, the invited person will be required to login to
the Google account you entered in the sharing window. After entering the
login credentials the spreadsheet will open to enter volunteer hours.

You can manage the the sharing settings any time by opening the share window,
clicking on “"Advanced” at the bottom and from the Advance screen just delete
any user you no longer want to be able to edit the file. When you have finalized
the hours for the current report year you may want to remove edit rights so
changes are not inadvertently made.

Opening the Volunteer Reporting Spreadsheet

Chapter members will open it in one of two ways, using a web link they receive
in an email or directly from their Google account under the Drive App. The email
message is sent automatically when a Chapter has Shared the Chapter’s active
spreadsheet to a Chapter member who will be responsible for recording the
volunteer hours.

Open from an email message

1. Open the email message and click on the web link.

2. If prompted, Login to the Google account the file was shared to.

3. Once open you can enter volunteer hours in the Data sheet/tab and run
the report by selecting the Build Report menu item.

Open from your Google Drive

1. Login to your new Google Chapter account or the Google account where
the Chapter has Shared the Chapter’s active spreadsheet to a Chapter
member’s Google Gmail address.

2. In the upper right corner of your screen you will see a ‘person’ icon, this
indicates if you’re logged on and to which account (if you have a separate
personal account).

3. Also see the small square of dots in the upper right hand corner of the
Google page. When you pick it a drop-down will appear. Pick “Drive” to
see the page below.

4. From Google Drive, open the “Shared With Me” folder. In the list look
for name created by your Chapter.

5. Next we want to Move the shared file under "My Drive” to make it easier
to find each time.
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6. Hold down the CTRL and ALT, keys at the same time press and hold the
left mouse button while on the file name. Wait for 1-2 seconds and slightly
move the mouse, you will notice a blue square with the filename change
in size. Drag the file over on top of the "My Drive” and release the mouse
button. Next you can release the keys on the keyboard. This will NOT
make a copy but move the link to the file so it is under the "My Drive”
folder.

IT IS VERY IMPORTANT YOU DO NOT MAKE A COPY OF THIS FILE AND
USE IT.

& Drive Shared with me =
“ Name Shared by Share date ¥
Today
» B3 MyoDrive
. :E] NV-Voluntesr Hours Reporting Preliminary o Lindy & Marty Co-Chairs 12:47 pm
I n  Shared with me & P g ’ : :
A . Earlier this week
4~ Google Photos
@ Rt E Mt Hood Chapter_Edited.doc o Barb Chair & Windy Co-Chair  Jan 28, 2016

7. Now open "My Drive” and Double click on the moved file link and it will
open in a new window.

8. If you delete this file name, you are only deleting the file link and not the
actual file itself that was shared to your account.

Additional help with getting started with Google Apps.

e https://apps.google.com/learning-center/products/quickstart/
e https://admin.google.com/user/hub

Data Entry

Data is entered on the sheet labeled “"Data”. Google Sheets does support
multiple entry of data, to be safe, it is best if only a few (2-3) members of each
Chapter enters the data (at exactly the same time) into the sheet labeled
“Data”. Each Chapter will manage their own Chapter’s active spreadsheet. This
helps to ensure the volunteer names, the required fields and the performed work
data are accurately entered. The data can be entered in any order but do not
leave blank rows in between names. You can insert rows so you can group your
data how ever you want to make it easier for you. The report program does not
care.

NOTE: Initially the spreadsheet will come with a Sample Data sheet. It just
allows the report to run so it can produce sample reports. As soon as you enter
anything on in the Data sheet, the Sample Data sheet will be ignored by the

OET Volunteer Hours Report Generator - Getting Started
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report building program.

With the Chapter’s active spreadsheet open, look at the bottom of the screen
and pick the ‘Data’ tab. This is the only place to enter your Chapter’s data. On
the ‘data’ sheet, start on the first line and enter each person’s name from the
paper Hours Report form that was turned in to you. Then fill in the appropriate
fields for each person. Be sure to spell each person’s name the same every time
it's entered. Activity Date, Agency & Chapter Name are required fields.

e There is no ‘save’ function. Whatever you enter is saved automatically,
and can be edited or deleted to correct mistakes. You can close the
window at any time and what you’ve entered will be preserved.

e To add additional event’s hours start entering those names on the next
available line (under the previously entered names), from the paper hours
report form that was turned in to you. Do not skip any lines between
event entries.

e Repeating names is "OK"”, but take care to spell them the same way each
time they're entered. A misspelled name gives hours to a separate person
instead of the real owner.

e If you wish, you can Build Reports at anytime. See “Information Sheets”
above. To Build Reports, pick the ‘Build Reports’ drop down button,
located under the file name near the top of your screen, and pick the ‘by
Individuals & Agencys’ option. The work sheet will do some blinking &
flashing while it reads the ‘data’ tab and creates the new totals tabs. If
you get an error message, such as indicating you have not entered data
for certain agencies, read it closely and determine if you've left out
pertinent information or not. If so, you can fix that after the report
building is done. To get past the error report hit ‘ok’. When the report
finishes, a prompt will indicate the report completed successfully. Add or
fix the information, if need be, and rebuild the report.

Now you are done! Close the window and go for a ride.

Data Fields

The following data fields are provided.

Full Name - This is a required field. The program does not look for different
spellings of a volunteer's name, they must be spelled the same for each person
every time they’re entered. The names are automatically capitalized and any
space at the end and beginning of the field are removed. The report program
does check for an empty entry (line without a name), and will display a popup
error window.

Project Name - Any description here can be used. The program removes any
space at the end and beginning of the field. Currently there are no reports

OET Volunteer Hours Report Generator - Getting Started
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created based on the Project. It is there only to help with viewing the raw data.

Activity Date - This is a required field. This is a date field and provided with
data enter is a down arrow to click on enabling a calendar entry app to open to
make it easier to pick a date from a calendar. The program does check for a
valid date and the field will also indicate if the date value was entered correctly.
This field is used to determine if this item is included in the Fiscal Year data or
the Calendar Year data sheets.

Agency - This is a required field. This is an agency acronym that can be
manually typed or selected from a drop down menu. The sheet field will also
indicate if the agency value was entered correctly. The report program does
check for a valid entry and will display a popup error window if not valid.

District or Location - Provides a place to enter a descriptive name for an
agency district or location of event. The program removes any space at the end
and beginning of the field.

Chapter Name - This is a required field and is automatically set. The Chapter
name can also selected from a drop down menu.

These fields, Skilled Work Hours, Field Work Hours, Admin. & Education
Hours, Public Meetings Hours, Travel Time Hours, Driver’'s Vehicle Miles,
Stock Hauling Miles, Power Equipment Hours, Heavy Equipment Hours,
Donations Material Value, Stock Days, and Stock Used correspond to the
volunteer related work and travel hours described on the OET standard volunteer
work sheet document filled out at events. The data here is not checked, a
number should be entered for any of these fields. Round up to the nearest hour.

First Time Running the Report Program

The first time the spreadsheet report program is run, the spreadsheet report
program will cause your account to ask to allow the spreadsheet report program
access to run under your account. To enable the OET volunteer hours report
generator to run you must give it permissions for it to run. See the section below
on Managing your Chapter’s Volunteer Hours spreadsheet.

In the first prompt select “"Continue” and on the second window click on “allow”.

Authorization Required

This app needs authorization to nun.

Cancel

OET Volunteer Hours Report Generator - Getting Started
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G https://accounts.google.com/o/oauth2/auth?client_id=80979251982-rgb6hf7jrpu

GO gle marty @pacssi.com
~ MasterVolunteerHoursReportBuilder would like to:
@ Wiew and manage your spreadsheets in Google Drive
L Wiew and manage the files in your Google Drive

@ Send email as you

By clicking Allow, you allow this app and Google to use your information in accordance
with their respective terms of service and privacy pelicies. You can change this and

other Account Permissions at any time.
Deny m

Running the Report

Associated with the spreadsheet is a report building program you can run at
anytime to see the results of your entered data. DO NOT MAKE CHANGES OTHER
THAN TO ENTER YOUR DATA ON THE DATA SHEET.

e To run report, select Build Reports->By Agencies and Individuals
from the menu at the top of the spreadsheet

Each time the report building program is run, it will reset/erase and recreate all
the report sheets in the spreadsheet. The individually created report sheets can
be copied to another spreadsheet, printed, saved as a PDF, or downloaded as an
Excel Spreadsheet. The intent is to provide these reports so you can provide
them to the agencies you work with.

NOTE: Initially the spreadsheet will come with a Sample Data sheet. It just
allows the report to run so it can produce sample reports. As soon as you enter
anything on the Data sheet, the Sample Data sheet will be ignored by the report
building program.

e Volunteer Totals Report showing your Chapter's volunteer hours and
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$dollar value totals, for Jan. 1st to Dec. 31st
Volunteer Totals By Individual, for Jan. 1st to Dec. 31st.
Volunteer Totals By Individual without OET Administrative, for Jan. 1st to
Dec. 31st.

e Volunteer Totals By Agency,(FS, BLM, OPRD, ODF, ODFW, County, &
Other) Jan. 1st to Dec. 31st

e \Volunteer Totals By Individual, for State Parks (ORPD), Jan. 1st to Dec.
31st

e Volunteer Totals By Individual, for US Forest Service District 6, Oct. 1, (of
previous year) to Sep. 31, (of current report year)

e \Volunteer Totals By Individual, for Bureau of Land Management (BLM) 6,
Oct. 1, (of previous year) to Sep. 31, (of current report year)

e \Volunteer Totals By Individual, for Oregon Department of Forestry (ODF),
Jan. 1st to Dec. 31st

e \Volunteer Totals By Individual, for Oregon Department of Fish & Wildlife
(ODFW), Jan. 1st to Dec. 31st

e \Volunteer Totals By Individual, for Local County or City Municipal Parks,
Jan. 1st to Dec. 31st

What if | Get an Error or Have a Problem

The active volunteer reporting spreadsheet in use by your Chapter is
automatically shared to the OET VP of Field Service and the OET Web
Administrator. If you have questions on entering data or happen to get an error
while running the report generator program we can directly access your active
Chapters spreadsheet and quickly resolve any question, problem or error you
may have run into.

Report Sheets

The spreadsheet includes 3 different types of formatted sheets, the Totals sheet,
the report sheets and data sheets. The tabs at the bottom of the spreadsheet
allow you to select a particular sheet. The Totals sheet derives totals from the
“Ind” report sheet found left of all other sheets. Report sheets are placed left of
the sheet named “Data” and data sheets are placed to the right. For each report
sheet there is a corresponding data sheet. For example the “nn Ind” report sheet
gets the totals values from the “nn-1"” data sheet where nn represents your
Chapters initials.

This spreadsheet includes a number of Tabs (sheets). Some are initially created
to provide the basic look of the final reports, most others are created
automatically. Some sheet names beginning with a Chapter’s two letter
abbreviation for your Chapter, i.e. (here we are using North Valley Chapter as an
example) NV OET, NV Agency, NV Ind, Data, NV-A, NV-I, Cal Year, and Fiscal.
There are also tabs for US Forest Service (NV USFS), Oregon Parks and
Recreation Dept. (NV OPRD), BLM (NV BLM), Oregon Department of Forestry

OET Volunteer Hours Report Generator - Getting Started
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(NV ODF), Oregon Department of Fish & Wildlife (NV ODFW), County (NV CNTY)
and TOTALS. Each of these agency sheet tabs are automatically created based
on the data found. If your Chapter hasn’t reported hours for an agency then that
sheet tab will not be created for that agency.

Information Sheets

The only sheet on the spreadsheet you enter volunteers hours in is called
“Data”. The others are generated automatically. Below is a short description of
the sheets on the Volunteer Reporting Automated Spreadsheet.

TOTALS sheet - Includes the totals of all volunteer work categories along with
the dollar value for volunteer labor for a Chapter.

Ind (Individuals) sheet - This report sheet includes the total volunteer hours for
each Chapter member along with an overall total. This is a calendar year report.

OET sheet - This report sheet includes the total volunteer hours for each Chapter
member excluding the newly OET Administrative reported hours. This is a
calendar year report.

Agency sheet - This report sheet includes the total volunteer hours for each
agency along with an overall total. This is a calendar year report.

FS sheet - This report sheet includes the total volunteer hours for each Chapter
member along with an overall total that performed work on US Forest Service
District 6 managed land for the Fiscal Year, October 1st thru September 31st.

BLM sheet - This report sheet includes the total volunteer hours for each Chapter
member along with an overall total that performed work on Bureau of Land
Management (BLM) lands for the Fiscal Year, October 1st thru September 31st.
If there is no BLM data this report will not be included.

OPRD sheet - This report sheet includes the total volunteer hours for each
Chapter member along with an overall total that performed work at Oregon
State Parks, (OPRD) lands for the Calendar Year, January 1st thru December
31st. If there is no OPRD data this report will not be included.

ODF sheet - This report sheet includes the total volunteer hours for each Chapter
member along with an overall total that performed work for Oregon Department
of Forestry (ODF) managed lands for the Calendar Year, January 1st thru
December 31st. If there is no ODF data this report will not be included.

ODFW sheet - This report sheet includes the total volunteer hours for each
Chapter member along with an overall total that performed work for Oregon
Department of Forestry (ODFW) managed lands for the Calendar Year, January
1st thru December 31st. If there is no ODFW data this report will not be
included.

CNTY sheet - This report sheet includes the total volunteer hours for each
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Chapter member along with an overall total that performed work for the County
(CNTY) managed lands for the Calendar Year, January 1st thru December 31st.
If there is no CNTY data this report will not be included.

Setting Report Year and Other Control Values

There is an exception to any rule! We do say DO NOT CHANGE ANYTHING on the
spreadsheet other than to enter the data. In this case the TOTALS sheet is also
used to tell the report program which year to make the report for, so the sheet
labeled “TOTALS” controls the year of the report and the dollar amount valued
for OET’s volunteer time. We may add other controls here in the future to
provide some other user control on how reports are generated.

For the volunteer dollars we use the values shown here at this web site,
https://www.independentsector.org/volunteer time. For the year 2015 the latest
value is estimated to be $23.07. On the “"TOTALS"” sheet change the dollar values
to be current.

Edit this column to change the published values
Current Rate per hour'mile/day:
523.07 )
534.61 1.5 X Basic
523.07
523.07
523.07

To change the Year of the generated report, change the year value shown on the
“TOTALS"” sheet. The Report Program pulls the year value to determine which
data entries to use. If the Year set on the "TOTALS” sheet contains no data
associated with it in the “Data” sheet, the report will produce an error popup. In
the test example the data is for 2016 (Oct. 1, 2015 to end of 2016).

Oregon Equestrian Trails

Volunteer Hours Report for 2015
North Valley Chapter

Fate per
Totals hour/mile/day Total Value
Total Basic Hours 2835 $23.07 %6,540.35 | Calculated per hour
Taotal Skilled Hours 1452 $3461 £50,246.46 | Calculated per hour
Total Education 945 $23.07 $2,180.12 | Calculated per hour
Total Public Meetings 59 $23.07 $1,361.13 | Calculated per hour
Total Travel Time 657.25 523.07 $15,162.76 | Calculated per hour

OET Volunteer Hours Report Generator - Getting Started
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Log in to My Google Account and Open Google Drive

As when running Google Apps, it is best to use Google Chrome. In Google
Chrome or other web browser application go to http://www.google.com, in the
upper right corner click “Sign in” in the upper right corner. If you see something
else you may already be logged in to a Google Account.

If you need to switch or change the account see the section below on switching
to another account.

Also see the small square of dots in the upper right hand corner of the Google
page. This is the Google App Launcher. When you pick it a drop-down window
will appear showing a number of icons. Pick “Drive” to see and access your
Chapter’s active spreadsheet to enter your volunteer hours.

€ = C | @ httpsy/accounts google.com/ServiceLogin?sacu=1#identifie ?

Google

1. Enter: www.google.com s B e
. ICK on Sign In
" One account. All of Google.

Sign in with your Google Account

Google

3. Enter: your Google Username

4. Click Next

Google Search I'm Feeling Lucky

Need help?

Explore the history of Civil Rights with Google

mn

G Google

One account. All of Google. s
9 G @

My Account  Search Google+

'@ Google ™M 1 (&

8. Click on Google Drive
]

Sign in with your Google Account

5. Enter: your Google Password

6. Click Sign In Marty DeVall
= _ Docs. Sheets Slides

Signin What wil you make better? Google Science Fair 2016 is

x
& = C @ https//www.googlecom 7. Click to open App Launcher

Google h h i m@o &

For additional help with getting started with Google Apps.

e https://apps.google.com/learning-center/products/quickstart/
e https://admin.google.com/user/hub

OET Volunteer Hours Report Generator - Getting Started
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Switch to a Different Google Account

If you see the icon in the upper right hand corner in the web browser window

click on the icon to enable you to logout or add another user. It could be a

picture of you if you have added a profile picture or an icon showing the upper
torso and head.

) . S Clicking on the OET logo
Lindy & Marty Mail Imaz mmm gl
' ¢ Mail Images Q) @ in this example will give

you the option to add an
This account is managed by apps.oregonequestriantrails.org. .
Learn more account you can pick from

each time or pick Sign

Lindy & Marty Co-Chairs — out, so you can sign in as
northvalley @apps .oregonequestriantrails org a different user.

Privacy

Next you can Sign in with
m a different account that
provided access to your

Chapter’s active volunteer
reporting spreadsheet.

Add account Sign out

L I i/

For additional help with getting started with Google Apps.

e https://apps.google.com/learning-center/products/quickstart/
e https://admin.google.com/user/hub

After logging onto your Google

Go gle account you will see a ‘person’
icon near the upper right
corner of your screen. This

One account. AH Of Google. indicates if you're logged on
Sign in with your Google Account and to which account your
logged into.

Need help?

Create account

One Google Account for everything Google
GMmROD L *HE

OET Volunteer Hours Report Generator - Getting Started
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